
Experimental Lesson for an 
Onscreen Calculus Course: 

the Definition of the Derivative

This file is a demonstration of a prototypical onscreen lesson implementing 
several instructional design ideas.  The main intent was to experiment with a 
design principle of John Sweller (Instructional Design in Technical Areas, ACER 
Press, 1999) on using audio to increase working memory capacity and hence 
improve learning.  (A table describing Sweller’s principles, interpreted some-
what in the context of this lesson, may be found at the end of this file; the 
reader is strongly encouraged to look at the book for details and the research 
upon which they are based.)  Other instructional design ideas are described 
by annotations to the pages which follow, and at the end in Pedagogy Notes. 
Details of the technology used can be found in Technology Notes.  For com-
ments or questions, please email June Lester <jalester@cecm.sfu.ca>

http://www.amazon.com/exec/obidos/ASIN/0864313128/
mailto:jalester@cecm.sfu.ca


Instructions for the Demo.  

To hear the voiceovers, click on the  
speaker icons (try this one).

To read the annotations, double click on the comment 
icons (try it here).  These aren’t part of the lesson;  
they have been added for this demo only.

Acrobat settings for optimal viewing (optional):  Since the pages are different 
lengths, it’s best if the view you choose  (under the View menu) is “actual 
size”.  Also choose the page layout “single page” from the View menu to see 
one page at a time.  In order to see useful page numbers in the status bar (at 
the bottom of the window), check the “use logical page numbers” box in the 
Preferences > General... popup window (look under the right arrow at the top 
right of the Acrobat Reader window).  Also check the “use page cache” box in 
this same window to speed up loading of individual pages (if you have suffi-
cient RAM).

June Lester
You can change the font used for these notes from the File > Preferences > Annotations popup window in Acrobat Reader.  To make the notes look like the rest of the text, change the font to Verdana 12.To close this window, click the close box in the upper left corner.



Lesson 3.1
Slopes of Curves; Derivatives

What this lesson is about:

This lesson introduces the most fundamental idea of the course: the 
derivative. As you work through the lesson, you will learn how to 

•  find the slope of a curve at a given point on it 
•  define the derivative of a function at a point 
•  use the definition to calculate derivatives. 

What you need to know to understand this lesson:

•  what the slope of a line is and how to calculate it
•  how to calculate limits

This lesson should take you P - Q hours to complete.

Commentary
Since the instructor will not normally be present to provide a context for the lessons, it is important to specify the learning objectives of each lesson.

Commentary
For a hierarchical subject such as mathematics, it is important to specify pre-requisites for each lesson.  This becomes more and more critical as onscreen instruction becomes more modularized to allow alternate paths through the material.

Commentary
This information is important to allow learners to budget time.  It becomes even more important for non-traditional students with multiple claims on their time.The time required for this lessson has yet to be determined. 



What you should know about slopes of lines (review).

Commentary
The purpose of this short review is to ensure that students can associate various values of the slope with appropriate visual images, important for an intiutive understanding of much of this course.

Commentary
Note the red and blue colours for graphs, chosen to be easily distinguishable by those with red/green colour deficit.  In general, onscreen information highlighted by colour should also be understandable without it.For further information on onscreen colour discrimination, see the  Vischeck color-blindness simulator <http://vischeck.com/>.



Slopes of lines are difference quotients.



What do we mean by the slope of a curve?



Explore a sample curve close up. 

curve:   y = 1
10 x(11− x)    point:  (1,1)

       

The shape of the zoomed curve ... 

When you’ve finished calculating ... 

Commentary
This particular curve was chosen to simplify calculations as much as possible while still producing a graph with moderate slopes. In particular:•  several points on the curve have integer coordinates, so the example can be reused  without complicating the calculations•  division by the denominator 10 is numerically trivial.

Commentary
The computer icon is both an indication that a computer is to be used and a link that opens a math workbook file (in the full version, not in this demo).  These links can be configured to open either a blank workbook or one pre-configured with the example or problem under discussion.



Do this same exploration algebraically.

curve:   y = 1
10 x(11− x)    point:  (x1, y1) = (1,1)

nearby point:

   

x2 = 1+ h

y2 = 1
10 (1+ h) 11− (1+ h)[ ]

= 1
10 (1+ h)(10 − h)

= 1
10 (10 + 9h − h2 )

= 1+ (0.9)h − (0.1)h2
    

difference quotient:

∆y
∆x

= y2 − y1

x2 − x1

=
1+ (0.9)h − (0.1)h2[ ]− 1

(1+ h) −1

= (0.9)h − (0.1)h2

h
= 0.9 − (0.1)h

What this difference quotient tells you:  

Suppose you do this over and over ...  

Commentary
Note the pink and blue highlighting here.  This was introduced to make individual "chunks" of the expressions immediately visible, rather than assuming students will recognize the chunks merely by reading through the details of the calculation.



Now make what you just did more general.  

      

•  general curve  y = f (x)    
        

•  general  point on it (a, f (a)) 

•  zoom

•  nearby point   (a + h, f (a + h))

•  difference quotient

∆y
∆x

= f (a + h) − f (a)
(a + h) − a

= f (a + h) − f (a)

h

    

Definition

The slope of a curve y = f (x)  at the point 
(a, f (a)) on it is the limit of a difference 
quotient: 

slope = lim
∆x→0

∆y
∆x

= lim
h→0

f (a + h) − f (a)
h

if this limit exists.

Find the slope of the curve y = 1
10 x(11− x)  at the point (6, 3) on it by 

zooming and then check your answer algebraically.

Commentary
Since we're now focussing on the individual steps of the process, they are listed in point form.

Commentary
Definitions, formulas and other critical pieces of information are placed in frames to make them easily scannable.

Commentary
Questions marked with a check mark are "concept checks" - a means for the student to check that he understands the immediately preceding material.  The questions are normally quite straightforward.  Students will be instructed to consult the course tutor if they have problems with these questions that remain after re-reading the material.



Defining derivatives.

    

Definition

For any function y = f (x) , the limit

′ f (a) = lim
h→0

f (a + h) − f (a)
h

if it exists, is called the derivative of f  at x = a .

  For the function f (x) = 1
10 x(11− x) , since the slope of y = 1

10 x(11− x)
at (1,1) is 0.9, we have ′ f (1) = 0.9.  What is ′ f (6)?  

 For f (x) = 37x + 73, find ′ f (13) “by inspection”; that is, without 
graphing the function or doing a calculation.

Commentary
A question marked with a "thought balloon" indicates "something to think about" - in general, a short question that requires more thought than calculation.  Students who have difficulties with such questions will be instructed to consult the course tutor.



Calculating Derivatives

To do these warmups, you’ll need to remember the derivative formula 

′ f (a) = lim
h→0

f (a + h) − f (a)
h

.

Sample

Calculate the derivative of x2  at x = 1.le 

Solution  Here a = 1 and f (x) = x2 , so

 
 
 

  

′ f (1) = lim
h→0

f (1+ h) − f (1)
h

= lim
h→0

(1+ h)2 − 12

h

= lim
h→0

1+ 2h + h2( ) −1

h
= lim

h→0
2 + h{ }

= 2

Put in the value of a .

Put in the function f .

Simplify and calculate the 
limit.

Done

Exercises

Calculate some of the following derivatives.  You’ve warmed up 
enough once you can do these fairly quickly without having to look up 
the formula each time.

a)  the derivative of x3 at x = 2  e)  the derivative of 1− 7s  at s = 5
b)  ′ F (5) for F(t) = (t − 5) t f)  ′ g (0) , given g(x) = x 2 − 2x
c)  the derivative of x5/3  at x = 0 g)  the derivative of cos x  at x = 0
d)  ′ f (0) if f (x) = sin x h)  ′ s (−1) when s(x) = (x + 1)ex

Commentary
The icon here is meant to symbolize a person doing sit-ups - a type of warmup exercise.

Commentary
The green "flags" which mark the start and finish of an example, etc. are meant to "enclose" it a little - to chunk it by making it visually separate from the surrounding material.

Commentary
The yellow "pointers" are  to "gloss" the example - to provide comments, hints, suggestions and short explanations of the steps.

Commentary
The point of these warmups is to help the student automate the first steps of the derivative calculation; the simplification step for each is therefore trivial.  Students are told how well they should be able to do the warmups, and will be expected to do as many as they need to reach that level.  As soon as they decide that "OK, I can do these", it's time to move on.



Answers to the Warmups

a)  0  e)  −7
b) 5 f)   −2
c)  0 g)   0
d)  1 h)  e−1

Commentary
The different decor for the solution pages is meant to provide a visual cue to the student that he is looking at a solution to an assigned problem and not at a worked example.  Ultimately, all solution pages may be placed in a separate "back of the book" file and merely linked to from the problem pages.



Problems for Lesson 3.1

 

Example 3.1.1

Calculate the derivative of f (x) = 1
x + 3

 at x = 2 .

Solution  

If the function is a fraction,  
it’s neater to write division 
by h  as multiplication by 1/ h.

′ f (2) = lim
h→0

f (2 + h)− f (2)
h

= lim
h→0

1
h

1
[2 + h]+ 3

− 1
2 + 3

 
 
 

 
 
 

= lim
h→0

1
h

1
5+ h

− 1
5

   
   

= lim
h→0

1
h

5− (5 + h)
(5 + h)5

 
 
 

 
 
 

= lim
h→0

1
h

−h
(5 + h)5

 
 
 

 
 
 

= lim
h→0

−1
(5 + h)5

= − 1
25

Generally, you don’t want to 
multiply out the h  in the 
denominator - you want a 
separate factor h  available 
in the denominator to cancel 
out an h  in the numerator.

Done

Problem 3.1.1

Calculate the derivative of f (x) = 1
x

+ 3 at x = 2 .

Commentary
These are the "real" problems for the lesson.  Note the format: a worked example followed immediately by a similar problem.This section of the lesson is designed for possible printing in a study guide (i.e. the examples are meant to be understandable without voiceovers).

Commentary
Clicking on the green "Problem" flag takes the student directly to the solution of the problem.



Example 3.1.2

For f (x) = 1
x

, calculate ′ f (9).

Solution  

′ f (9) = lim
h→0

f (9 + h) − f (9)
h

= lim
h→0

1

h

1

9+ h
− 1

9
  
 

  
 

= lim
h→0

1
h

3− 9 + h
3 9 + h

 
 
 

 
 
 

= lim
h→0

1
h

3− 9 + h
3 9 + h

× 3+ 9+ h
3+ 9+ h

 
 
 

 
 
 

= lim
h→0

1

h

9 − (9 + h)

3 9 + h 3+ 9+ h( )
 
 
 

  
 
 
 

  

= lim
h→0

−1
3 9 + h 3+ 9 + h( )

= −1
3 9 3 + 9( )

= − 1
54

Rationalize the numerator.

Don’t waste time multiplying 
out the denominator here.

Now simplify the denominator.

Done

 

Problem 3.1.2

For f (x) = 7− x , calculate ′ f (3).



Example 3.1.3

Calculate the derivative of f (x) = (x + 4)tan πx
3( ) at x = −4 . 

Solution  

′ f (−4) = lim
h→0

f (−4+ h)− f (−4)
h

= lim
h→0

[−4 + h]+ 4( ) tan π[−4+h]
3( ) − −4+ 4( ) tan π[−4]

3( )
h

= lim
h→0

h tan π[−4+h]
3( )

h

= lim
h→0

tan π[−4+h]
3( )

= tan −4π
3( )

= − 3

Done

 

Problem 3.1.3

For s(t) = et sin t , find ′ s (π).



Solution to Problem 3.1.1

Calculate the derivative of f (x) = 1
x

+ 3 at x = 2 . 

′ f (2) = lim
h→0

f (2 + h)− f (2)
h

= lim
h→0

1
h

1
2 + h

+ 3 
 

 
 −

1
2

+ 3 
 

 
 

 
 
 

 
 
 

= lim
h→0

1
h

2 − (2 + h)
(2 + h)2

 
 
 

 
 
 

= lim
h→0

−1
(2 + h)2

= − 1
4

Done! 



Solution to Problem 3.1.2  
  

For f (x) = 7− x , calculate ′ f (3).

Rationalize the numerator.

′ f (3) = lim
h→0

f (3 + h) − f (3)
h

= lim
h→0

7− (3+ h) − 7− 3
h

= lim
h→0

4 − h − 2
h

= lim
h→0

4 − h − 2
h

× 4 − h + 2
4 − h + 2

= lim
h→0

(4 − h) − 4
h 4 − h + 2( )

= lim
h→0

−1

4 − h + 2

= −1
4 + 2

= − 1
4



Solution to Problem 3.1.3
   

For s(t) = et sin t , find ′ s (π).

′ s (π) = lim
h→0

s(π + h) − s(π)
h

= lim
h→0

eπ+h sin(π + h) − eπ sin(π)
h

= lim
h→0

−eπ+h sin(h)
h

= − lim
h→0

eπ+h × lim
h→0

sin(h)
h

= −eπ ×1

= −eπ

since  sin( π+ h) = −sin( h)  
and  sin( π) = 0

since  lim
h→0

sin(h)

h
= 1



Pedagogy Notes: the Lesson Format

The lesson has three basic teaching/learning goals, addressed by different 
segments of the lesson.

1. Understanding, addressed by a segment of explanation.  In this particular 
lesson, we would like the student to understand on an intuitive level what a 
derivative is (the slope of a curve looked at close up) and that the formula for 
a derivative comes from this idea.

2. Automation, addressed by the “warmups” segment following the explana-
tion.  The warmups are “baby” problems, designed only to help the students 
acquire the necessary schemata for solving more substantial problems.  In this 
particular lesson, the warmups are to help the student automate the first 
steps of calculating a derivative: remembering the formula, substituting in the 
point, and putting in the function correctly.  The remaining details of the calcu-
lations are deliberately trivial simplifications; this is not the place for challeng-
ing problems.

Students are not expected to do all of the warmups; instead they are told 
how well they should be able to do them to be sufficiently “warmed up” before 
moving on.  It is anticipated that brighter students will do one or two warmups 
and less able students several more.  There are deliberately more warmups 
than most students will want to complete, to bore even the most anxious stu-
dent into moving on to more stimulating problems.

3.  Transfer, addressed by a problems segment at the end of each lesson.  
We now want the students to apply what they’ve practiced in the warmup 
sections  to “real” problems.  This section consists of several worked examples 
each followed by a similar problem to be completed (with a link to the solu-
tion).  The worked examples are annotated to point out subtleties in the cal-
culation, suggestions for doing calculations more efficiently, etc..  In general, 
this section can include more challenging problems (e.g. Problem 3.1.3); alter-
nately, challenging problems can be left for a more extensive problems section 
at the end of the current module.



Design and Technology Notes

•  File format  The lesson is in the format of a PDF file, currently the most ef-
fective way of producing onscreen mathematical text.  PDF files have other 
useful features: the pages can be different sizes (allowing more appropriate 
chunking of content than print), and can contain multimedia elements such as 
links, sound, movies, etc..  

• CAS  The lesson is meant to be used with a CAS (a computer algebra sys-
tem, such as LiveMath) capable of graphing and zooming in on graphs readily.   
The clickable icon  is used to indicate that a CAS is to be used, and can link 
either to an empty CAS notebook or one pre-configured with the example at 
hand.

•  Page design  The font used is Verdana 14, for its screen readability (the 
KILL rule - keep it large and legible).  Devices such as bullets, headings, 
boxes, etc, are used to further chunk content (see C. Kilian, Writing for the 
Web, Self-Counsel Press, 1999).  “Flags” are used to chunk examples, etc. by 
marking their beginning and end; these were drawn in Illustrator and fused 
with an editable text box in AppleWorks 6.  The rounded lesson and section 
headers were designed to reflect the other rounded page elements (speaker 
icons, flags, ... ), and the pastel colours were chosen to enhance the content 
structure without competing with it for attention.

• Technology used to create pages  The graphs were created in LiveMath and 
edited in Illustrator.  The pages were assembled in AppleWorks 6, using 
MathType to create the mathematical text, and then converted to PDF files. 
Adobe Acrobat was used to add links and sound files, which were recorded in 
Sound Studio.

•  File size  The main drawback to using voiceovers this way is file size: this 
present file is close to 7 meg.,  and would make a prohibitively slow download 
for an online course (though byteserving the file would make for a shorter 
“subjective” download time).   As part of a course delivered on CD-ROM, it 
would work fine (based on an estimate of 40 lessons of about the same size), 
with room left over for supplemental material.

http://www.amazon.com/exec/obidos/ASIN/1551802074/
http://www.amazon.com/exec/obidos/ASIN/1551802074/
http://www.livemath.com
http://www.mathtype.com
http://www.felttip.com/products/soundstudio/


Sweller’s Instructional Design Principles 
(somewhat interpreted in the context of this lesson)

Use audio

Since visual and aural working memory appear to be separate, using both 
can increase total working memory.  Audio should be restricted to non-tech-
nical parts of the material to be learned (motivation, intuitive explanations, 
instructions, ... ).  To avoid redundancy, it should not merely reproduce 
printed text: talk about the text or diagram.  If possible, audio should be 
student-controlled, to be listened to when needed and as often as needed.

Avoid simultaneous presentation of the same material in different formats 
(e.g. as diagram labels and as separate text).  Reading redundant material 
is an extraneous load on working memory; the material cannot be ignored, 
since it cannot be seen to be redundant until after it has been read.  Elimi-
nate the extraneous material.

Avoid redundancy

Integrate any textual information necessary for understanding graphical ma-
terials directly into those materials.  Instruction or information about a graph 
or diagram that needs to be processed to understand it should appear di-
rectly on the graph or diagram.  If textual material necessary for under-
standing is physically separate from the diagram, the student is forced to in-
tegrate them mentally, increasing the working memory load unnecessarily.

Avoid split attention

Increase the number of worked examples relative to the number of prob-
lems to be solved.  Students learn concepts and techniques more readily by 
studying worked examples than by puzzling them out through problem- 
solving. Students peeking at the answers in the back of the book for hints 
may be indicating a need for more worked examples.

Use worked examples

Construct problems that encourage students to work forward from the giv-
ens towards an unspecified goal.   Example: “find the derivative of ...” is 
goal-free, while “show that the derivative of ... is ...” is not.  Problems that 
encourage students to work back from a known goal to the givens require 
extra “means-end” analysis not contributing directly to learning.  Discourage 
students from checking the answer to a problem for a “hint” before attempt-
ing a solution, as this will turn a goal-free problem into one with a goal.

Use goal-free problems
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